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1.Ajalooliste aerofotode maht 

Juhend on koostatud Maa-ameti Fotolao andmebaasi põhjal, mis on osa magistritööst1. Sinna 

on koondatud Geoloogiakeskuse, Maa-ameti, Keskonnaagentuuri ja Tartu Ülikooli 

Raamatukogu vanad aerofotod.  

Aerofotode tabeli koostamisel võeti arvesse ajaloolise aerofotomosaiigi alla koondatud 

georefereeritud fotod, mis on leitavad üksikute kaadrite otsingusüsteemist ja mida on enamasti  

võimalik alla laadida. Tervest Maa-ametis digitaliseerimisel olevast materjalist on siiani 

geopositsioneeritud ligikaudu 10%, kuid Fotokogu täieneb pidevalt. Tabelisse juhendi lõpus 

on koondatud maakondade kaupa piirkonda katvate aerofotode hulk ja maht.  Lisaks 

ajaloolistele aerofotodele saab andmebaasist vaadata erinevaid satelliidifotosid. 

 

 

2. Fotode otsimine 

 

Juhend fotode otsimiseks on olemas Maa-ameti koduleheküljel. 

Seal on olemas õpetus üksikute piltide otsinguks:  

ja ülevaade 1943. ja 1963. aasta kaardilehtede nomenklatuurist. 

2.1. Muistised fotodel 

Andmebaasi fotod võivad olla abimaterjaliks muististe lokaliseerimisel - eriti neid, mis 

Nõukogude Liidu aegse maaparanduse käigus võiksid hävitatud olla. Ajalooliste aerofotode 

põhjal on võimalik leida maapealseid muistiseid - kalmeid ja lohukive, keerulisem on leida 

asulakohti ja põllujäänuseid. 

 

3. Kuidas otsida endale sobivat aerofotot? 

 

Võtan vaatlusaluseks Mõnnaste küla Viljandimaal. 

 

Aerofotod leidsin kerge vaevaga “koosseadete” alt (kui foto on seal olemas, siis leiab selle 

märksa kiiremini üles kui  aerofotomosaiigi alt). Näen andmebaasist, et “koosseadete” all 

leidub Mõnnaste küla kohta mitmeid kaarte. Mind huvitavad kõige varasemad 1950. aasta 

Geoloogiakeskuse fotod.  Foto parempoolsele servale on kirjutatud: 

 

 
1 Holter, S. 2020. Ajalooliste aerofotode kasutusvõimalusi arheoloogias: Maa-ameti Fotolao andmed. Magistritöö. 

https://fotoladu.maaamet.ee/
https://geoportaal.maaamet.ee/est/Kaardirakendused/Fotoladu/Fotoladu-aerofotode-digitaalarhiiv-p545.html
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Aerofotol oleva informatsiooni põhjal on leitav nii lennu numbri, ülelennu aasta ja kuupäeva 

kui foto numbri – 6558. Lisan foto numbri ja aasta üksikute kaadrite otsingusse (vajadusel ka 

allika ja foto tüübi, kuid antud otsing andis kohe õige tulemuse): 

 

 

3. 1. 1943 kaardilehtede nomenklatuuri põhjal 

Vaatlusaluseks piirkonnaks valin Ilmandu küla Harju maakonnas. Esmalt otsin  põhjal, 

kas andmebaasis üldse leidub sobivat materjali. Näen, et Ilmandu kohta on 1959. aasta 

aerofoto, mis mulle huvi pakub. Kuna foto on noorem kui 1963, otsin fotot 1942. aasta 

kaardilehe põhjal: 

 

Otsin välja õige ruudustiku, kuhu Ilmandu võiks jääda.  Paistab olevat O-35-13 ja lisan selle 

otsingusse: 

https://geoportaal.maaamet.ee/est/Andmed-ja-kaardid/Koordinaatsusteemid-ja-kaardilehtede-jaotused/Kaardilehtede-susteemid/1942-a-susteemi-kaardilehtede-nomenklatuur-p225.html
https://geoportaal.maaamet.ee/est/Andmed-ja-kaardid/Koordinaatsusteemid-ja-kaardilehtede-jaotused/Kaardilehtede-susteemid/1942-a-susteemi-kaardilehtede-nomenklatuur-p225.html
https://geoportaal.maaamet.ee/est/Andmed-ja-kaardid/Koordinaatsusteemid-ja-kaardilehtede-jaotused/Kaardilehtede-susteemid/1942-a-susteemi-kaardilehtede-nomenklatuur-p225.html
https://geoportaal.maaamet.ee/est/Andmed-ja-kaardid/Koordinaatsusteemid-ja-kaardilehtede-jaotused/Kaardilehtede-susteemid/1942-a-susteemi-kaardilehtede-nomenklatuur-p225.html
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Otsing leidis 89 erinevat aerofotot. Vaatan, kas saan täpsustada “Foto tüüpi”, et 

otsingusüsteemi vähendada. Kui see tulemust ei andnud, siis on palju abi ka lähedalasuvatest 

maamärkidest, mis vähendab otsinguvaeva ning mida ma päris tihti kasutan, kui on võimalik. 

 

Vaatan, et Ilmandu küla juures asub Muraka raba, mida aerofotodelt on kergem tabada.  

 

 

 

Leiangi otsingust samalaadse foto, kus on peal ka Muraka raba ning mulle huvipakkuv 

piirkond. Fotot on võimalik alla laadida.  

 

Alati sellest nipist kasu ei ole, kuid võimaluse korral vähendab see tunduvalt otsimisvaeva.  
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3.2. 1963 kaardilehtede nomenklatuuri põhjal 

 

Valdav enamus vanemaid kui 1963. aasta ülelende on leitav “koosseadete” alt, kuid teen näite 

läbi Vormsi saarega. Näiteks pakub mulle huvi 1987. aasta ülelend -  otsin 1963. aasta 

kaardilehe põhjal, millisesse ruudustikku piirkond kuulub: 

 

 

Otsin taaskord välja õige ruudu, kuhu Vormsi võiks jääda. Selle põhjal C-58-20. 

Kui otsin selle ruudu fotosid üksikute fotode otsingust, siis vaatan, kas ehk foto asub 

“koosseadete” all. Leiangi 1987. aasta ülelennu fotod ning otsin huvipakkuva piirkonna foto 

välja samamoodi nagu enne mainitud. Otsingusüsteem leiabki õige foto ning soovi korral saan 

selle ka alla laadida.  

 

3.3. Mis saab, kui mõne piirkonna aerofotosid alla laadida ei saa?  

 

Mõnikord on näha, et foto on andmebaasis olemas, kuid seda ei õnnestu andmebaasist alla 

laadida. Sellisel juhul on foto olemas digiteeritud kujul, kuid Maa-ametil need aerofotod 

paberkandjal puuduvad. 

 

Üheks selliseks piirkonnaks on Mäletjärve küla Tartumaal. Näiteks soovin uurida Mäletjärve 

külas,  

olevat kaitsealust kalmistut (12873). Näen andmebaasist, et koosseadete all eksisteerivad 

ülelennud 1975. ja 1980. aastatest.  

 

https://geoportaal.maaamet.ee/est/Andmed-ja-kaardid/Koordinaatsusteemid-ja-kaardilehtede-jaotused/Kaardilehtede-susteemid/1963-a-susteemi-kaardilehtede-nomenklatuur-p229.html
https://geoportaal.maaamet.ee/est/Andmed-ja-kaardid/Koordinaatsusteemid-ja-kaardilehtede-jaotused/Kaardilehtede-susteemid/1963-a-susteemi-kaardilehtede-nomenklatuur-p229.html
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Panen otsingusse aasta ja foto numbri, kuid tulemuseks tuleb: 

 

 
Kui fotot ei ole võimalik alla laadida ning jooniseid koostada, kuid enamik fotosid peaks 

siiski olema hea kvaliteediga, saab seda vaadata ainult süsteemis.  

 

3.4. Geopositsioneeritud fotod kaardil 

 

Andmebaasis on positsioneeritud valet värvi metsanduslikud aerofotod ning üksikud 

ajaloolised aerofotod, mis on alla laetavad ning mida saab kasutada muististe uurimisel.  
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4. Fotode kandmine QGISi 

 

Näiteks soovin georefereerida Mõnnaste kivikalmeid Tarvastu kihelkonnas. Selleks avan 

QGISi:  

New Project → Properties → Project Properties → Estonian Coordinate System 1997 

 

Seejärel tuleb aktiveerida georefereerimine, märkides ikooni ette linnuke: 

Plugins → Manage and Install →  Georeferencer GDAL  

 

Ikoon ilmub rippmenüüs Raster alla: 

 

 
 

Seejärel: Georeferencer → Open raster. 

 

Otsin arvutist üles, kuhu laadisin aerofoto ja avan. Kuna tegemist on äärmiselt suure fotoga, 

siis soovituslik on foto lõigata väiksemaks, näiteks kasutada selleks IrfanView programmi. 

 

 
 

https://www.irfanview.com/


7 

Seejärel kannan nii ajaloolisele fotole kui kaasaegsele aluskaardile ühiseid punkte – selleks 

kasutan  Add point ja klikin kaardil. Ühiseid punkte võiks olla võimalikult palju, et 

saada võimalikult täpne kaart. Delete point eemaldab ühised aluspunktid.  

 

 
 

Kui olen punktide lisamisega valmis, siis valin  Start Georeferencing  → Transformation 

Type ja ajalooline aerofoto ilmub aluskaardil.  

 

Aluskaarte saan muuta parempoolse menüü juurest, muutes linnukesi kaardikihtide ees. 

 

4.1. Punktide salvestamine 

Soovituslik oleks punktid salvestada, sest siis saab georefereeritud kaarti ka hiljem kasutada. 

 

Selleks vali: Save GCP Points as…. 

 

4.2. Joonised 

Joonise tegemiseks ava: 

Project → New Print Layout →  Adds a new Map to the layout 

Move item content aitab liigutada kaarti vastavalt vajadusele ja suurusele. 

Kordinaattelje lisamiseks ava:  Add Item → Add scale bar 

Ilmakaare lisamiseks: Add Item → Add picture → Search directories 

Teksti lisamiseks: Add Item → Add text  
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Kõige lõpuks: Layout → Export as image 

 

 

 
Tegin kaks kõrvutavat joonist, mis kujutavad tänapäevast situatsiooni ja näitavad kalmete 

paiknemist 1950. aastal. Tekstiga lisasin peale kaitsealuste kivikalmete registrinumbri - 

noolega viitasin kalmele, mis on nähtav ajaloolisel aerofotol.  

 

4.3. Valguse-varjudega mängimine 

Valguse ja varjude reguleerimine võib aidata paremini muistiseid fotodelt otsida.  

 

Fotode heleduse ja tumeduse reguleerimiseks mine: 

Layer Properties → Symbology 

 
 

 

 



9 

 

Kategooriate all on “Brightness”, “Saturation”, “Contrast” ja “Strength”, mida reguleerides saab 

reguleerida foto heledust ja tumedust.  
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Tabel digitaliseeritud fotodest maakonniti. NB! Fotod ei kata maakondi täielikult.  

 

 

 

Maakond 

Katvad 

kaardid Ülelennud ja aasta Arhiiv 

Üksikud 

piirkonnad 

Harjumaa 8 

1951 

1959 

1969 

1971 

1971 

1972 

1973 

1974 

Geoloogiakeskus 

Keskkonnaagentuur 

Maa-amet 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Maa-amet 

Maa-amet 

1939 (Kopli 

poolsaar) 

1940 (Juminda) 

1941 (Kehra) 

1941 (Kautjala) 

Raplamaa 5 

1951 

1968 

1970 

1971 

1973 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Maa-amet 

Maa-amet 1941 (Kohila) 

Lääne-Virumaa 8 

1959 

1968 

1969 

1971 

1980 

1980 

1987 

1988 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Maa-amet 

Geoloogiakeskus 

Maa-amet 

Geoloogiakeskus 

Geoloogiakeskus Rakvere 

Ida-Virumaa 7 

1959 

1962 

1962 

1970 

1971 

1973 

1988 

Geoloogiakeskus 

Geoloogiakeskus 

Maa-amet 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Geoloogiakeskus 

1941 (Narva) 

1941 (Kauksi) 

Jõhvi 

Viljandimaa 10 

1948 

1950 

1960 

1963 

1966 

1967 

1968 

1970 

1978 

1984 

Geoloogiakeskus 

Geoloogiakeskus 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Maa-amet 

Maa-amet 

Geoloogiakeskus 

Maa-amet 

Geoloogiakeskus  

Tartumaa 4 

1948 

1966 (Piirissaar) 

1972 

1972 

Geoloogiakeskus 

Geoloogiakeskus 

Geoloogiakeskus 

Maa-amet  
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Võrumaa 9 

1947 

1966 

1968 

1969 

1970 

1972 

1975 

1981 

1993 

Geoloogiakeskus 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Maa-amet 

Maa-amet 

Maa-amet 

Maa-amet 

Maa-amet 

Parksepa 

Tonja 

Antsla 

Võru 

Osula 

Põlvamaa 5 

1947 

1965 

1966 

1972 

1975 

Geoloogiakeskus 

Geoloogiakeskus 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Veriora 

Meemasküla 

Jõgevamaa 6 

1948 

1960 

1966 

1967 

1970 

1972 

Geoloogiakeskus 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Geoloogiakeskus 

Geoloogiakeskus Põltsamaa 

Järvamaa 7 

1950 

1951 

1970 

1971 

1971 

1974 

1980 

Geoloogiakeskus 

Geoloogiakeskus 

Geoloogiakeskus 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Maa-amet  

Valgamaa 6 

1947 

1948 

1969 

1974 

1981 

1993 

Geoloogiakeskus 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Maa-amet 

Maa-amet Valga 

Pärnumaa 10 

1950 

1959 

1963 

1963 

1966 

1967 

1970 

1972 

1983 

1984 

 

Geoloogiakeskus 

Geoloogiakeskus 

Geoloogiakeskus 

Maa-amet 

Geoloogiakeskus 

Maa-amet 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Geoloogiakeskus 

1941 (Virtsu) 

1941 (Sindi) 

Pärnu 

Ikla 
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Saaremaa 6 

1955 

1968(Muhu) 

1969 

1974 

1975 

1985 

 

Geoloogiakeskus 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Maa-amet 

Geoloogiakeskus 

Kesselaid 

Orinõmme 

Tornimäe 

Kaisvere 

Ninase 

Abruka 

Papissaare 

Mõnnaste 

Läänemaa 7 

1951 

1959 

1963 

1968 (Vormsi) 

1978 

1981 

1987 (Vormsi) 

Geoloogiakeskus 

Geoloogiakeskus 

Maa-amet 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Geoloogiakeskus Paslepa 

Hiiumaa 6 

1955 

1968 

1968 

1970 

1974 

1984 

Geoloogiakeskus 

Geoloogiakeskus 

Maa-amet 

Maa-amet 

Maa-amet 

Geoloogiakeskus  

muu (Petserimaa) 1 1950 Geoloogiakeskus  

muu (Lämmijärve 

idakallas) 1 1965 Geoloogiakeskus  

muu (Aluksne 

rajoon) 1 1975 Maa-amet  

     

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


